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HOW TO USE THIS LAB WORKBOOK 

This workbook contains 30+ labs that will show you how to use the Policy Manager and Gateway to protect your 

APIs and Web Services. We introduce each lab within the context of an airline, Voonair.  You can use this lab 

workbook at the prompt of your instructor once you cover the basics and configure the API Gateway. 

This workbook assumes you have a Gateway in RUNNING status as well as the Policy Manager application 

running and connected to that Gateway. It also assumes you have access to the various supporting files (ie. 

.wadl and .wsdl files). 

PRE-REQUISITES FOR THE LABS 

 You need to have your API Gateway .ova up and running. For configuration instructions please refer to the 

Gateway Configuration Guide as part of your training handouts.  Start VMPlayer and click the virtual 

instance of the Gateway that you configured.  

 You need the Policy Manager installed and licensed, as per the configuration guide. And running. 

 SDE Environment – this is the .zip file that should be made available in your training folder and is installed in 

stage 5 of the configuration guide. It is expressed as a .tgz file. 

 Access to provided training assets to a local or shared folder. This folder contains docs, licenses, etc. 

THE MODULES AND THEIR CORRESPONDING LABS 

 

Remember Voonair?  

The map to the right outlines the 9 distinct Modules that this workbook will take you through.  

These are designed to help you learn about the features in the Policy Manager. Follow this airline and the 

characters involved to see how Voonair wins by using the CA API Gateway toolset. 

 

 

 

 

 

 

THE GATEWAY TRAINING ENVIRONMENT 

To be able to complete the labs in this workbook, you will need to set up the training environment.  



We start by setting up the Virtual Machine and the training environment. 

The training environment (simulated backend services, ex. LDAP Server, a Soap and Rest service exposed by the 

2nd gateway) allows you to simulate an end-to-end message flow. In the labs that follow, you will be sending 

messages from the client to the backend services and writing policies on the Gateway that affect that message. 

 

 

 

  



 

 

 

 

 

 

 

 

 

 

 

 

 



THE GATEWAY ARCHITECTURE 

The diagram below outlines the different layers involved in calls between clients and backend services. The 

Gateway sits in the processing/runtime layer. This chart shows how you can have various configurations 

including a standalone gateway or a cluster. 

 

  



MODULE 1  

PUBLISHING A SOAP WEB SERVICE 

LAB 1A: PUBLISHING A SERVICE 

THE SITUATION 

Voonair has never exposed their APIs to external partners and want to make sure their systems are secure when they do 

this. They already have their application running and have provided us a description via a .wsdl file for publishing on the 

Gateway. 

THE SOLUTION 

In order for Voonair to accomplish all of their business goals, they need to start by publishing web services (or, APIs) which 

will expose their data to partners. It is currently sitting as an unused .wsdl file. 

This process can be started in the Policy Manager tool by writing and publishing web services.  Let’s go! 

Step 1: Make sure your Gateway is up and running.  Click the Policy Manager icon on your desktop, or from your Start 

Menu. In the Tasks menu, select the option titled Publish SOAP Web Service. 

 

 

 

  



Step 2: In the wizard, click file and import the voonair.wsdl from the training folder. Once you have located the WSDL, click 

Next to continue. 

 

Step 3: Define a custom resolution path for the service. We recommend /lab1. Then, click Next.  

 



Step 4: Click Next again to allow anonymous access.

 

Step 5: Click in the url window and select Change. Replace the default URL with the one in the box below. This is case 

sensitive. Click Finish.  The newly created Web Service will appear in the bottom left Services Panel of your Policy Manager.  

  



Below is where you can see your newly created Web Service. 

 

 

You have successfully published a web service! 

  



LAB 1B: SETUP THE SOAPUI CLIENT APP REQUEST 

THE SITUATION 

Now that Voonair has published a SOAP web service and generated a URL that can receive requests for the service, you 

need to create a client request. Think of this request like individual requesting flight information from a remote location. 

THE SOLUTION 

We will use soapUI to create an external request and point it to the published Gateway service.  Think of it like a 2-way 

conversation that we’re setting up. However, our 2-way conversation is going to be moderated and mediated and, in effect, 

changed by the Gateway as the request is passed through it. The Gateway is moderating the conversation between the 

customer and Voonair’s flight inventory. 

Step 1: Start the soapUI application.  (from the SmartBear folder in your Program Files via your Start Menu) 

Step 2: Click File, then New SOAP Project. Add a project name.  

Step 3: Click Browse.  Locate the WSDL titled: voonair.wsdl in the training folder provided. 

 

Step 4: Setup your client request by expanding <+> the voonairreservationDetails menu option and double-clicking 

Request 1.  



 

 

Step 5: Edit your endpoint to point to your newly published service on the gateway (e.g. that resolution path you set as 

/lab1). You can edit the endpoint by clicking the drop-down arrow to the right in the URL field and selecting [edit current 

..] 

 

Step 6: Manually change port 6060 to port 8080 as you edit the endpoint to be the Gateway URL that receives requests for 

this service. Refer to:  

 

Step 7 – Change the client message element “Destination” to a WSDL defined name (eg Montreal) and “startingpoint” to a 

WSDL defined name (eg. Vancouver).  Run the request by selecting the green arrow. 



  

Your response should look like the following message if successful: 

 

LAB 1C: PUBLISH A WEB API 

THE SITUATION 

The first thing Voonair wants to do is make it easier for their customers to book and check flights. To do this, they need to 

find a way to get their reservation system exposed via an API. 

Voonair has just recently purchased the gateway to expose their reservation system to partners, such as travel agencies.  

When exposing APIs to external partners they want to make sure their systems are secure when they do this. They already 

have their reservation application running and have provided us with a REST API to expose via the Gateway. 

THE SOLUTION 

In order for Voonair to accomplish this goal, they’ll need to publish a web API (Publish Web API) which will expose their 

data to the travel agencies.  



This process can be started in the Layer 7 Policy Manager tool by writing and publishing a web API service.  Let’s go! 

Step 1: Start by clicking Tasks and selecting “Publish Web API” 

Step 2: The Publish Web API Wizard appears: 

  

Service Name – Is a description of the API – Lab 1 C 

Gateway URL – Is the gateway URL that will expose this API – Rest/Lab1 

Step 3: Click Finish.   

Step 4: In order for us to test this service with a browser, we need to add a “Return Template Response to Requestor” 

assertion. 

 



Drag “Return Template Response to Requestor” to the policy development window.  Type in the Response Body – “Hello 

World” and in the Response Content Type – “text/plain; charset=UTF-8” 

Click Ok and Save and Activate 

Step 5 – In order to test this service out, you can bring up a Web Browser.  Place the Gateway URL in the browser area: 

http://gateway_URL:8080/Rest/Lab1 

 

  

http://gateway_url:8080/Rest/Lab1


MODULE 2:  

TROUBLESHOOTING  

LAB 2A: ADD AUDIT DETAILS 

THE SITUATION: 

Developer Dave is upset. A peer mistakenly deleted one of his policies. Dave needs to learn how to debug and 

recover his work. Not only is he having trouble debugging problems, he needs to create more new services 

THE SOLUTION: 

Dave delves into the Gateway functionality for logging, debug mode, and recovery.  Follow the instructions in this series of labs 

to learn how to set up audits within the Policy Manager.  

Step 1 – Drag and drop the Add Audit Details assertion into your new policy before the routing assertion. 

  

Step 2 - Add a message to the assertion that you want logged in the policy and select Log and OK. 
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Step 3 – Add a second message to the assertion that you want logged after the routing assertion and select Log, 

change the drop-down menu to WARNING and then OK. Save and Activate. 

 

You will now have 3 lines in your policy: 

 

Step 4 – Send a SOAPUI request to the gateway service listening on port 8080 or port 8443. Then, within the Policy 

Manager select View, then View Logs to see your message. 
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Step 5: Wait for the list to generate. Scroll to the bottom of the page,you’ll see your latest soapUI requests 

including the first message and second message (info vs warning) that the audits generated.  

 

Does this help Developer Dave? Not enough. So let’s move on to the next stage in this lab. 

LAB 2B: AUDIT MESSAGE IN POLICY 

THE SITUATION 

This isn’t enough. Dave needs to see both the successful AND failed attempts when he runs through his tests.  He 

will need to override the overall audit settings in order to view both the request and response messages. 

THE SOLUTION 

Dave turns on additional detail auditing by inserting “Audit Messages in Policy” at the top of his policy.  This will 

elevate all messages to WARNING and capture the request and response in the audits. 

Step 1 – Using the same soap service, drag and drop the Audit Message in Policy assertion into your soap policy 

before the add audit details assertion. 
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Step 2 – Double click on the Audit Message in Policy.  Change “save request” and “save response” buttons to 

Always. Click OK. 

 

Step 3 – Save and activate your policy 

  



[Type text] 

 

API Gateway Foundations – Lab Workbook v8.3 

 

Step 4 - Send a soapUI request to the gateway service listening on port 8080 or port 8443 and then within the 

Policy Manager select “View” -> “Gateway Audit Events” to see your audits. 

 

So what does this tell us? Some info, but not all. 
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LAB 2C: SETTING DEBUG MODE ON 

THE SITUATION 

Not all is resolved.  Dave needs more information on the success AND failure of each assertion in order to 

troubleshoot the coding issue. 

THE SOLUTION 

Dave needs to enable the Debug feature  

Step 1 – Right click on your existing service & pick “Service Properties” 

 

Step 2 – Toggle on the “Enable policy Debug Tracing” 
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Step 3 – Click Yes to edit  

 

Step 4 – Edit the “Audit Detail” that’s highlighted below.  When you double click on the assertion, delete the first 3 

trace info variables, and make sure the ones that are highlighted below are what’s left within the assertion.  Click 

OK and “Save and Activate” the debug trace policy. 

 

Step 5 – Send a soapUI test request and note the additional logging for your service the Policy Manager select 

“View” -> “View Logs”  
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LAB 2D: REVISIONS 

THE SITUATION 

Dave needs to recover work from a previous version after making some changes that are causing errors in the 

policy. 

THE SOLUTION 

Use the policy revisions feature to recover an old version.  You have the choice of making it active or just viewing it 

for reference. 

  

LAB 2E: EXPORT/IMPORT POLICIES 

THE SITUATION 

Dave heard that there is a library of awesome assertions that he can download from the CA Layer 7 Support Portal. 

This will save him SO much time. So …  

THE SOLUTION 
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Dave goes to the support portal to download policies. He saves them and then wants to import them into the 

Policy Manager to view. Show Dave how to export and import policies to make his life easier…. 

Step 1 – Click on the “Export Policy” and save the name of exported file (e.g. lab1).  View the contents of this file in 

an editor and not that it is a readable XML format. 

 

Step 2 – Make some changes to the current master policy and “Save and Activate” the policy 

Step 3 – Click on the “Import Policy” from the upper tool bar and navigate to the previously saved policy. 
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Step 4 – note that the changes you made are removed and you have recovered your original version that was 

exported.  Click “Save and Activate”. 

 

LAB 2F: SERVICE DEBUGGER 

THE SITUATION 

Dave needs to be able to look at different break points within policy.  He needs to know what variables that are 

being set, which path the policy is taking and be able to follow the different encapsulated assertions that get called 

within policy.  So if the policy refers to a policy fragment / encapsulated assertion than the service debugger will 

follow through to those outside of policy. 

THE SOLUTION 

Dave wants to increase his troubleshooting capabilities by wanting to see what happens during runtime.  He would 

like to follow the path of the service to see each assertion being invoked during runtime. 

1. When wanting to do this Dave will need to right click on the service in the policy/service area click 

“service debugger”.   

2. Click on Start to set the debugger to run for a test case 

3. Run a request through to that service and watch the bottom window fill up with variables and flow of the 

policy assertions. 
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MODULE 3: 

MESSAGE ROUTING & ERROR HANDLING 

LAB 3A: CREATE TEMPLATE RESPONSE 

THE SITUATION 

Dave needs to return a custom response to the client application to fulfill the business requirements for the new 

Voonair WebService 

THE SOLUTION 

There is a feature in the Policy Manager known as the return template response. Use it within an error condition 

to aid in customizing a response or troubleshooting. 

Step 1 – Within your current service created in earlier lab add the “Return Template Response to Requestor” by 

dragging and dropping the assertion into your policy.  Make sure it is after the current “HTTP/S Route” assertion so 

it overrides the default response. 

 

Step 2 – Make sure the template response properties matches the above.  Response Content Type = text/plain; 

charset=UTF-8.  Response Body = Hello World!!! 

Step 3 – Save and Activate.   Send a request to the service from SOAPUI and note the response you get returned 

now has the custom text you wanted returned. 
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LAB 3B: HTTP ROUTING ASSERTION 

THE SITUATION 

Dave needs to send a certain request off to the voonair web service.   

THE SOLUTION 

The Http Routing assertion allows Dave to direct a particular service request to a specific voonair web service. 

Step 1 – Create a new “Publish Web API” service and navigate to the “Message Routing” assertion folder.  Highlight 

“Route via http(s)”.  Drag the assertion into your policy development window. 

 

 

 

Place the location of the voonair rest service. 

 

For example = http://voonair.ca.com:8080/voonair/voonairreservations?startingpoint=vancouver 

 Step 2 –  Save and Activate 

Step 3 – Using your rest client run through a request 
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LAB 3C: CUSTOMIZE AN ERROR RESPONSE 

THE SITUATION 

Dave needs to return a custom error response to the client application to fulfill the business requirements for the 

new Voonair WebService.  Dave’s requirement is to route to a particular back end service but if it doesn’t respond 

than he needs to send the client a proper error message.  He also needs to fail the policy to alert the proper teams 

of the failure. 

THE SOLUTION 

There is a feature in the Policy Manager known as the “Customize Error Response”. Dave can use it within an error 

condition to aid in customizing a response or troubleshooting.  The above assertion plus a failure within policy 

(stop processing assertion) will provide exactly what Dave is requiring. 

 

Step 1 – Add to the existing service that you had built for the routing assertion example. 

Step 2 – Highlight the routing assertion within policy and right click.  Select “Add At least one assertion”. 

 

Step 3 – Drag the “Route via HTTP://...” assertion into the “At least one..” folder.  Highlight the “At least one 

folder” and click Add “And ALL..folder”. 

 

Step 4 – Within the policy assertion pallet search field do a look up “stop processing”.  Highlight and drag into the 

all assertion folder.  Next is to do a lookup of the “Customize Error Response” within the assertion pallet as well.  

Highlight and drag the assertion into the all folder, above the stop processing assertion.  Within the Response Body 

of the Customize Error Response, type “Routing Error” and make sure the Error Level is a “Template Response” 

with a response content type of “test/plain…” 
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Step 5 – Save and Activate the service.  Do a successful route test and then a failed attempt.  To invoke a failure 

just make an adjustment to the Routing statement.  (ie., change the port number from 8080 to 8000.) 

MODULE 4: IDM & RBAC 

LAB 4A: CREATE USERS 

THE SITUATION 
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Operations Oscar needs to create users within the Internal Identity Provider in order for them to access the Policy 

Manager. 

THE SOLUTION 

Create users within the Policy Manager with the Internal Identity feature. 

Step 1: Log into the Policy Manager.  Select Tasks / Create Internal User 

Step 2: Create 3 different users – Oscar / Andy / Dave  

 

 User Name = Oscar  

 Password = L7Secure$0@ 

 Repeat for the 2 other team members. 

Step 3: Create a group with the three users you have created. Most often identity management is done with a 

group so single users are not required to be managed in a master policy. 

LAB 4B: CREATE LDAP RESOURCE 

THE SITUATION 

Users within Voonair need to be authenticated.  Their LDAP connection will be used for both authentications 

within policy runtime and accessing the Policy Manager moving forward. 

THE SOLUTION 

Oscar needs to set up an LDAP connection to their internal directory service.  

Step 1 – To create an LDAP identity provider for the SDE environment, you must select – Tasks / Create Identity 

Provider / Create LDAP Identity Provider. 
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Step 2 – In the drop down arrow “Provider Type”, select GenericLDAP. 

Step 3 – Give the LDAP connection parameters specific to your gateway configured: 

 Host URL = ldap://your2ndGatewayIP   

 Search Base = dc=l7tech, dc=com 

 Make Sure the “Allow assignment to administrative roles” box is checked. 

 

LAB 4C: ROLE BASED ACCESS CONTROL 
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THE SITUATION 

Architect Andy phones Operations Ollie.  He wants to restrict access for developers to specific folders. He’s worried 

they may accidently change some of Ollie’s critical configuration for LDAP. 

THE SOLUTION 

RBAC, or ‘Role Based Assignment’ is possible within the Gateway.  Help Ollie to limit the developers access to 

developer functional roles like “Publish Webservices” 

Step 1 – From the Menu Item Tasks -> Manage Roles, use LDAP server and “Consultants” group so they can access 

the policy manager in a restricted view. Give this group the role of “Publish WebServices” and “Gateway 

Maintenance”.  Type “Publish Webservices” in the “Filter on Name: box”.  Highlight Publish Webservices and click 

“Add” at the bottom. 

  

Step 2 – In the Search menu, select the sde ldap from the list.  Press Search. 
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Select “Consultants” and press “Select” at the bottom.
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Step 3 – Repeat for “Gateway Maintenance” 

Step 4 - Disconnect from the Policy Manager and login as awaters (7layer) and see restricted 

permissions. 
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MODULE 5: POLICY LOGIC 

LAB 5A: CLUSTER WIDE PROPERTIES 

THE SITUATION 

Operations Oscar needs a better approach to maintain global environment variables.  Instead of having to update 

multiple services, he would prefer to update one area. 

THE SOLUTION 

You can do this by managing cluster-wide properties.  Show Oscar how to manage environments by adding a 

cluster wide property to your policy routing. 

Step 1 – Select “Tasks”, “Manage Cluster-Wide Property” and click Add. 

Step 2 – Highlight what’s in the key and delete. Tab to the value field, which will erase all that’s there. 

Step 3 – In the key field, type mysoaphost. Tab to the value field and place your 2
nd

 gateway acting as your back 

end web service.  

 

Step 4 – Click Ok.  
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Step 5 – Create another Cluster wide property and name it “myresthost”.   

Use the following Value = http://voonair.ca.com:8080/voonair/voonairreservations?startingpoint=montreal 

Step 6 – Within your existing published service click on the “Route via HTTP to …..”.  Update the URL of the route 

with the new cluster wide property.  Place the context variable calling the cluster wide property 

${gateway.mysoaphost} in the URL.  The prefix reference “gateway.” always is used to identify a cluster wide 

property. 

 

Step 6 – Save and Activate.  Send a request from SOAPUI to the service and check that you get a successful 

response. 

LAB 5B: CONTEXT VARIABLES 

THE SITUATION 

Dave needs to find out what variables are being set during run-time and also needs to know how to create context 

variables during this policy runtime. 

THE SOLUTION 

This lab walks you through how to create and reference context variables. 

Step 1 – Create a new REST service by using “Publish Web API”.  The new service name should be /Rest/Lab5. 

http://voonair.ca.com:8080/voonair/voonairreservations?startingpoint=montreal
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Step 2 – Press F1, to go to the Help menu for the layer 7 gateway.  In the Search window, type context variable and 

click on “Search”.  

 

Step 3 – Look up Message Layer Variables and Message Routing variables – Use the following variables: 

 ${request.http.uri} ${service.name} 

Step 4 – Find in the assertion palette “Add Audit Details”.  Drag this into above the route vis http 

assertion. 
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Drag one more “Add Audit Details” after the route.  This time using referencing the response message.   

Response = ${response.mainpart} 

Routing latency = ${httpRouting.latency}  

http status = ${response.http.status}  

 

Step 5 – Drag and drop the audit message in policy into the top of the service.  
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Step 6 – Save and Activate.  Send a request through to the gateway.  Check “view – Gateway Audits Events” 

Step 7 – The service should look like this:   

 

Step 8 – Save and Activate.  Test the service and take a look at the audits, by “view” and “Gateway Audits”.  Here’s 

what it should look like.  First Audit Details: 
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LAB 5C: CREATE AND COMPARE CONTEXT VARIABLES 

THE SITUATION 

Developer Dave needs to do learn how to do comparisons for some business logic Business Man Bill has 

communicated.  Help Dave out by creating a sample in policy logic. 

THE SOLUTION 

It’s time to create some context variables and make use of them in policy logic. 

Step 1 – Re-use a previous lab or copy to a unique lab to identify this exercise. 

Step 2 – Drag and drop “Set Context Variable” into the service before the route.  The assertion lives in the Policy 

Logic folder within the assertion palette. 

 

Step 3 – Place the Variable name as “test”.  Keep the default setting of String for the data type and change the 

expression field to true.  Select ok. 

Step 4 – Drag and drop the “Add audit details” to below the set context variable assertion.   
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Step 5 – Save and Activate.  Send a request through to the gateway. 

Step 6 – Check the Gateway Audit Events, by clicking on the shortcut “Audit Alerts Waiting” button in the upper 

right hand corner.  

  

Click view audits: 

 

Step 7 – Re-use the same service.  Drag and drop the Compare Expression to above the Route. 

 

Step 8 – Set up the Expression field with the context variable that you created earlier in the service.  Change the 

Data Type to be the same as your variable that was set (string).  If Multivalued field, should read “All values must 

pass”.  Click Add. 
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Step 9 – The above wizard shows up, click on Simple Comparison and click Ok.

 

Step 10 – Save and Activate. Send the request through.  See that it passes; now, change the “test” context variable 

to false.  See what happens when you send your request through now. 

You should see “Assertion Falsified in your response. 
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 In the Gateway Audit Events, this is what will appear: 

 

LAB 5D: POLICY BRANCHING 

THE SITUATION 

Dave needs to do some policy branching to enable the ‘if … than’ statements.  He needs to determine within a 

policy how to only allow a certain user to access a backend service.  All other users get denied or receive an error. 

THE SOLUTION 

Dave must enable policy branching logic and needs your help! 

Step 1 – Create a new Web API service or copy an existing one. 

Step 2 – Find the assertion “require HTTP Basic Credentials” within Access Control folder.  Place this into the policy 

Development window.  Drag and drop the Audit message in Policy assertion to the top of the policy.  This ensures 

that the “required” credentials are present and in the right formate. 

Step 3 – Search in the Assertion palette for “at least one assertion”.  Drag the “at least one assertion must evaluate 

to true” into the policy.  This is the start of branching exercise. 
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Step 4 – Within the At least one assertion branch place 3 “all assertions must evaluate to true”.  Easy lookup, it’s 

just above the at least one assertion.  Drag and drop the assertion into policy on top of the at least one assertion in 

the policy, so it should look like this: 

 

Step 5: Within the top two “all assertions must evaluate to true”, drag and drop “Authenticate User or Group” into 

policy: 
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 Select the following user for the first authentication = Alisha Tan  

 2nd user for the authentication = Joe Dant 

Step 6 – Drag and drop the “Authenticate User or Group” assertion into the 3
rd

 All Assertion.  Selecting the Type as 

Groups: 
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 Select the Support group.  This is what it should look like at this stage: 

 

Step 7 – The last 2 assertions of this policy added are related to HTTP/S Routing.  Make sure the route is “not” 

within the nested logic and is the last assertion of the policy at this point.  The last assertion is placing another Add 

Audit detail assertion to the very bottom, looking at the resulting status of the HTTP  route to the back end. 
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Step 8 – Save and Activate.  Send the request using the browser window that was open from before.  When you 

send the request through you should have a pop up window allowing you to input user credentials.    

All passwords associated to the users in the SDE LDAP are 7layer.  The user in order to pass this service, use one of 

the 2 users (atan,jdant) and to test the group account, use jhayes. 

Note: - You will need to clean up the cache of your browser each time you run through this.   

 

     

Type in the user Name = atan 

Password = 7layer 

Step 9 – Check the Gateway Audits to see how the service ran through. 
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MODULE 6: FRAGMENTS & GLOBAL POLICIES 

LAB 6A: CREATE A POLICY FRAGMENT 

THE SITUATION 

Dave needs to start looking at modularizing his code because he has found out from Architect Andy that they will 

be deploying many more services in the near future. 

THE SOLUTION 

Implement Policy Fragments in the policy so that other services can utilize the same logic without repeating 

development.   

Step 1: Create an Included Policy Fragment 

 

Step 2:  Copy Authentication Logic to  accessControlFragment 

Step 3:  Delete or disable previous logic in Master Policy and use “Include Policy Fragment” assertion to reference 

the new logic from the policy fragment created. 

Step 4:  Test with SOAPUI to ensure new fragment executes the same logic without error.  Note that you cannot 

edit this within the master policy because it is a common piece of code used in many services. 

 

LAB 6B: CONVERT POLICY FRAGMENT TO AN ENCAPSULATED ASSERTION 

Step 1 - Select Tasks -> Manage Encapsulated Assertions option 

Step 2 - Select Create and fill in fields in pop-up window 
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LAB 6C: CREATE A GLOBAL POLICY 

Step 1 – Create a Global Policy from the TASKS->Create Policy 

 

Step 2 – Add and Audit Detail Assertion with a message in it 

Step 3 – Send requests from SOAPUI to 2 different services and note that the message is logged for both. 
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MODULE 7: ACCESS CONTROL 

LAB 7A: ACCESS CONTROL VIA INTERNAL IDENTITY 

THE SITUATION 

Operations Oscar controls who can have access to the Gateway.  He has some new-hires that he needs to grant 

access to. 

THE SOLUTION 

Learn how to create new users within the Internal Identity Provider. 

Step 1 – When logged into the gateway, navigate to the “Identity Providers” tab, beside the Assertions tab.  Under 

the Identity Providers root level of the window, there will be 2 providers, one from your SDE LDAP that we 

configured earlier and the Internal Identity Provider.  Right click on the “Internal Identity Provider”, click on 

“Create User”: 

 

Step 2 – Type Dave in the User Name field 

 

In the Password field use the following password (based on our stig requirements).  L7Secure$0@   Click Create. 

Create another user for Operations Oscar. (eg. Oscar). 
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Step 3 – To view the users within your Internal Identity Provider, you can right click on the Internal Identity 

Providers  

 

Step 4 – Create a new Soap Service with the same wsdl as all of the others.  Layer the Service with the following 

assertions: 

Audits = Audit Messages in Policy 

Requirement of credentials = Require HTTP Basic Credentials 

 

Step 5 – For this lab you will be authenticating against your internal identity provider.  Drag and Drop the 

“Authenticate Against Identity Provider” assertion to above the “Route via HTTP” assertion within policy.   

 

*** Important – The Authentication assertion must read “Request” at the front of the policy assertion.  If you 

moved the assertion into the service below the route, the first part of the assertion will read “Response: 
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Authenticate against…”.    You will also need to right click on the assertion and “Select Target Message”.  Change to 

Request for the target message. *** 

  

 

Step 6 – Save and Activate  

Step 7 – Go back to your Browser and run the request to /Rest/Lab7.  Change the username from one of the ldap 

sde usernames to oscar.  Send this request through. 

LAB 7B: RESTRICT ACCESS TO SSL OR TLS TRANSPORT 

THE SITUATION 

Security has decided that the services require SSL to prevent a hijack of personal information across the wire. 

THE SOLUTION 

Implement the assertion “Require SSL or TLS Transport”. 

Step 1 – Open up an existing service in the policy manager 

Step 2 – Drag and Drop the “Require SSL or TLS Transport” assertion to the top of your policy, above the “Route via 

HTTP”: 

 

Step 3 – Save and Activate.   

Step 4 – Send a request to the following gateway service URL on port 8080 (non-SSL).   
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You should see the policy fail, because we’re not meeting the need of SSL transmission. 

Step 5 –When you send the service to the same URL using the necessary SSL transmission of https and port 8443 

you should see a successful result.   
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MODULE 8: MESSAGE SECURITY 

LAB 8A: EXPLORE XPATH VALIDATION 

THE SITUATION 

Dave needs to extract a value from a SOAP message to make sure that it is below a specific value. 

THE SOLUTION 

Dave needs to learn how to extract data out of services with the Evaluate XPath Request/Response 

Step 1 – Build a new Soap service call it lab9 

Step 2 - Drag and Drop the “Evaluate Request XPath” into your policy before the Route HTTP/S Assertion 

 

Step 3 – Click on the “voonairreservations” Operation and highlight the startingpoint element.  Place startingpoint 

in the variable prefix box. 
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Step 4 – Use “F1” for help and search for the “XPath Request” (e.g.  startingpoint.results) you’ll find a list of 

context variables that get populated with this assertion execution. 

Step 5 – Put Logic in that checks the value of the “startingpoint” attribute and use the “Compare Expression” to 

make sure it is not equal to Vancouver.  Incorporate logic to handle an error condition.  
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LAB 8B – JSON MESSAGE TRANSFORMATIONS 

Step 1: Create a new Policy – Publish Web API – New Service = /Rest/Lab11 

Step 2:  In order to figure out the response from the backend and how it’s formed we need to setup our policy 

with just a routing statement and then place an “Add Audit Detail” assertion highlighting ${response.mainpart}.  

Like so: 

 

Run a request through to the URL and then go into the audits to gain access to the response from the back end: 

 

Copy out the response message from the audits. 

Step 3: Go back to your policy development window and Drag and Drop the “Evaluate response Xpath” assertion 

and place it below the route. 
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Click Add (Sample Messages area) 

Sample message window appears; paste the response message from the step previous into the XML Document 

window.  Click Ok. 

Select the “voonairreservationResponse” opening element. 
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Variable Prefix should be = voonair

 

Step 4: Set a message variable (xmlmessage) with the elements variable (voonair.elements). 

Step 5: Drag and Drop the “Apply the JSON Transformation” assertion, below the message variable set above.   

 

Make sure the target is “xmlmessage” and that you selected the Transformation = “XML to JSON” 
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Step 7: Set up some sort of failure response as well to get invoked if the xpath fails. 

 

When you test from a browser the response should look like this: 
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MODULE 9: THREAT PROTECTION 

LAB 9A: PROTECT AGAINST CODE INJECTION 

THE SITUATION 

Dave has a request from Architect Andy to secure their web services and prevent bad data from getting to the 

backend. 

THE SOLUTION 

Dave must learn how to enforce certain IT Security requirements 

Step 1 – Create a new Soap Service.  Service URL = lab10  

Step 2 – Drag and Drop the “Protect Against Code Injection” assertion into your policy, should be the first line in 

your policy.   Select all in the “Apply protection to” (URL Path, URL Query String, Body) and Select all “Available 

Protections”. 

 

Step 3 – Build out Policy like the following to handle the error that’s associated to the “protect Against Code 

Injection”.  Place the “At least one assertion” and move the code injection under it.  Drag and Drop the “All 

assertion must evaluate to true” assertion with a Customize error response. 
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Add a stop processing assertion below the error response. 

Step 4 – Place a require http basic and authentication to the sde assertion.  And a route via http to the 

“mysoaphost”. 

“Save and Activate”.   

Step 5 – Go back your soapui project and add authentication to the request, like so: 
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Username = atan 

Password = 7layer 

If you test the service like so, this should pass and you should get a response from the backend service. 

Step 6 – Now let’s invoke a failure – Place a known “code injection” into the request. 

 

In the startingpoint element type montreal; in the field provided.  You should get the response you placed in 

your customized error response. 

***** The stop processing forces the policy to fail.  You need to place this in the all assertion after the “customize 

error response”.  The customized error response assertion will only get invoked once there is a failure below it. 

*****  
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LAB 9B: INCLUDE POLICY FRAGMENT 

THE SITUATION 

Security has asked to apply threat protection services against the services 

THE SOLUTION 

Create a Policy Fragment and include these threat protection assertions. 

Step 1 – Create an “Include Policy Fragment”.  Select Tasks / Create Policy. 

 

Update the Name Field with – Threat Protection 

Select Policy Type = “Include Policy fragment” 

Select Ok. 

Step 2 – The Policy Fragment is created on the route of the policy and services area.  And the first line of the policy 

fragment is with an Add Audit Detail assertion with the name of the policy fragment. 
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Step 3 -  Drag and Drop different threat protection assertions from the Threat Protection folder: 

 Protect Against Code Injection  

 Protect Against Document Structure Threats 

 Protect Against SQL Attacks 
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Step 4 – Save and Activate. 

Step 5 – Add the “Include Policy Fragment” assertion into a policy.  Place this policy fragment at the top of the 

master policy where we would like this enforcement done before executing anything else in our policy. 

 

Disable the “Protect Against Code Injection” assertion that we placed in the policy earlier. 
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Update the customized error response with “Failed because of a possible Threat”  

“Save and Activate” the policy. 

Step 6 – Send a request to the service and note it is executed in-line of the master policy.   

Step 7 – Let’s cause the failures now: 

Fail with a Code Injection: 

Use the “;” (ie. Montreal;)  within the startingpoint element again to see if it fails again. 

 

If you go into the Audits, you should see the following: 

 

 

Fail with an XML document structure threat: 

Edit the Threat Protection and change the “Reject if XML element nesting depth exceeds:” from 32 to 3.   Click OK 

and “Save and Activate” the policy fragment: 
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Run a standard request through the gateway, without the (;), this should give you another type of error, same 

response: 

  

Change the XML Document structure back to 32 from 3.  Save and Activate the Policy Fragment. 

Fail with a SQL Attack threat: 

In the URL for your test case type the following to invoke a possible threat. 

http://Gateway_URL:8080/lab10?startingpoint=1;waitfor delay '0:0:10'— 
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LAB 9C: RESTRICT SERVICE AVAILABILITY 

Grant access to service 24x7 for a known company IP address but ONLY on weekends and evenings for everyone 

else. 

SOLUTION: 

 

 

LAB 9D: LIMIT THROUGHPUT 

SITUATION 

Create a policy that limits access to a service to only 5x per hour per authenticated user. When the maximum is 

met, create a return template response. 
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LAB 9E: SERVICE AVAILABILITY CACHE RESPONSE 

Using cache where possible is extremely valuable from a performance and perhaps cost saving basis.  Many 

companies use this for storing static or public data, but careful that you use it wisely and make sure the cache keys 

are unique for user data where necessary. 

SOLUTION: 

Step 1 – Create a Publish Web API Service, Name it /Rest/Lab12 

Step 2 – Use the lookup in cache and the store to cache feature. 
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Section 3: Gateway Operations 

AUDITING AND LOGGING 

LAB 1A: AUDITING 

THE SITUATION 

You need to create an audit sink policy. 

Step 1 – From Tasks > Manage Log/Audit Sinks > Manage Audit Sinks 

Step 2 – Import the sample policy: auditsinkpolicy-layer7-example.xml 

LAB 1B: LOGGING 

THE SITUATION 

Operations Oscar needs to setup the syslog server so that he can off-box the logs. 

Step 1 – From Tasks > Manage Log/Audit Sinks  

Step 2 – Highlight ssg log and click clone. 

 

 



[Type text] 

 

API Gateway Foundations – Lab Workbook v8.3 

 

 

 

Step 3 – Place a proper name for the syslog ssg log sink.  Select Syslog within the down the Type. 

Step 4 – Click the Syslog Settings tab. 
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Step 5 – Click Add and type the location of the syslog server.  Click ok and then close at the manage log sinks 

wizard.  

Step 6 – Go onto the syslog server and view the gateways log files.  Navigate to the following directory: 

Cd /var/log/syslog-ng/{gateway name} 

Tail –f messages  

 

SYSTEM CONFIGURATION 

LAB 4: CREATE A LISTENER PORT 

THE SITUATION 

By default we have 4 different listener ports. The listen ports open up an actual port that listens on the Gateway 

for any traffic that comes from the travel agency. When it receives a request from that travel agency, it will act 

accordingly. A listen port is a TCP port that ‘listens’ for incoming messages that are then passed to the Gateway 

message processor. This lab will walk you through how to configure the proper port for the Policy Manager.  

Step 1 – Select Tasks – Manage Listen Ports 

Step 2 – Click Create 

Step 3 – Edit the following properties within the wizard: 

Name = Policy Manager Access 

Protocols = https 

Port = 7443  

Enabled Features – Select “Policy Manager Access” and “Browser-based administration” 
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Step 4 – Click on Pool Settings tab and select “Use private thread pool” – guarantee 10 threads for accessing the 

policy manager. 

 

 

Step 5 – Click OK and Close.   

Step 6 – Disconnect and re-connect to the new port.  When you log into the policy manager make sure the URL has 

port 7443 at the end of it.  For example = gateway.ca.com:7443 


